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1. Related Manuals 
 
To ensure system safety, make sure to always read and follow the information provided in all 
Safety Precautions and Precautions for Safe Use in the manuals for each device which is 
used in the system.  
The table below lists the manuals provided by CKD Corporation (hereinafter referred to as 
"CKD") and OMRON Corporation (hereinafter referred to as "OMRON"), which pertain to this 
guide. 
 

Manufacturer Cat. No.  Model Manual name 
OMRON W500 NJ501-[]5[][] 

NJ501-[]4[][] 
NJ501-[]3[][] 
NJ301-12[][] 
NJ301-11[][] 
NJ101-10[][] 
NJ101-90[][] 

NJ-series CPU Unit 
Hardware User's Manual 

OMRON W535 NX701-17[][] 
NX701-16[][] 

NX-series  
CPU Unit  
Hardware User's Manual 

OMRON W578 NX1P2-11[][][][] 
NX1P2-10[][][][] 
NX1P2-90[][][][] 

NX-series  
NX1P2 CPU Unit  
Hardware User's Manual 

OMRON W501 NX701-17[][] 
NX701-16[][] 
NX1P2-11[][][][] 
NX1P2-10[][][][] 
NX1P2-90[][][][] 
NJ501-[]5[][] 
NJ501-[]4[][] 
NJ501-[]3[][] 
NJ301-12[][] 
NJ301-11[][] 
NJ101-10[][] 
NJ101-90[][] 

NJ/NX-series  
CPU Unit  
Software User's Manual 

OMRON W505 NJ/NX-series  
CPU Unit Built-in EtherCAT® Port  
User's Manual 

OMRON W504 SYSMAC-SE2[][][] Sysmac Studio Version 1 
Operation Manual  

CKD SMF-2006-A AX9000TS/TH/XS INSTRUCTION MANUAL ABSODEX 
AX SERIES 
TS TYPE TH TYPE XS TYPE 

CKD SMF-2012-A AX9000TS/TH-U5 Instruction Manual ABOSODEX AX 
Series 
TS type TH type EtherCAT specification 

CKD SMF-2005-A - INSTRUCTION MANUAL ABSODEX 
AX Tools for Windows® 
Common for TS-Type, TH-Type, 
MU-Type and XS-Type Drivers 
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2. Terms and Definitions 
 

Term Explanation and Definition 
PDO communications 
(Communications using 
Process Data Objects) 

PDO communications is used for constant data exchange 
between a master and slaves.  
PDO data (i.e., I/O data that is mapped to PDOs) that is 
allocated in advance is input and output each EtherCAT 
process data communications cycle (i.e., the task period of 
primary periodic task).  
The NJ/NX-series Machine Automation Controller uses PDO 
communications for commands to refresh I/O data in a fixed 
control period, including I/O data for slave units and the position 
control data for servomotors.  
It is accessed from NJ/NX-series Machine Automation 
Controller in the following ways.  
・With device variables for EtherCAT slave I/O 
・With axis variables for a servo drive and an encoder input 

slave to which an axis is assigned  
SDO communications 
(Communications using 
Service Data Objects) 

SDO communications is used to read and write specified slave 
data from a master when required.  
The NJ/NX-series Machine Automation Controller uses SDO 
communications for commands to read and write data, such as 
for parameter transfers, at specified times.  
The NJ/NX-series Machine Automation Controller can 
read/write the specified slave data (parameters and error 
information, etc.) with the EC_CoESDORead (Read CoE SDO) 
instruction or the EC_CoESDOWrite (Write CoE SDO) 
instruction.  

Slave unit There are various types of slaves such as servo drives that 
handle position data and I/O terminals that handle bit signals.  
A slave unit receives output data sent from a master, and sends 
input data to a master.   

Node address A node address is an address to identify a unit connected to 
EtherCAT.  

ESI file 
(EtherCAT Slave Information 
file) 

An ESI file contains information unique to EtherCAT slave units 
in XML format. You can load an ESI file into the Sysmac Studio, 
to allocate EtherCAT slave process data and make other 
settings.   
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3. Precautions 
 
(1) Understand the specifications of devices which are used in the system. Allow some 

margin for ratings and performance. Provide safety measures, such as installing a safety 
circuit, in order to ensure safety and minimize the risk of abnormal occurrence.  

(2) To ensure system safety, make sure to always read and follow the information provided in 
all Safety Precautions and Precautions for Safe Use in the manuals for each device 
which is used in the system.  

(3) The user is encouraged to confirm the standards and regulations that the system must 
conform to.  

(4) It is prohibited to copy, to reproduce, and to distribute a part or the whole of this guide 
without the permission of OMRON Corporation.  

(5) The information contained in this guide is current as of May 2017. It is subject to change 
for improvement without notice.  

 
The following notations are used in this guide.  
 

 

Indicates a potentially hazardous situation which, if not avoided, 
may result in minor or moderate injury, or may result in serious 
injury or death. Additionally there may be significant property 
damage. 

 

 
Indicates a potentially hazardous situation which, if not avoided, 
may result in minor or moderate injury or property damage. 

 
 

 Precautions for Correct Use 

Precautions on what to do and what not to do to ensure proper operation and performance.  

 

 Additional Information 
Additional information to read as required.  
This information is provided to increase understanding or make operation easier.  

 
Symbol 
  

 

The filled circle symbol indicates operations that you must do. 
The specific operation is shown in the circle and explained in the text. 
This example shows a general precaution for something that you must do. 
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4. Overview 
 
This guide describes procedures for connecting a CKD ABSODEX Driver AX9000TS/TH-U5 
(hereinafter referred to as the "ABSODEX Driver") to an OMRON NJ/NX-series Machine 
Automation Controller (hereinafter referred to as the "Controller") via EtherCAT and for 
checking their communication status.  
The explanations given in this guide assume the use of NJ-series Controllers.  
Refer to Section 6. EtherCAT Settings and Section 7. EtherCAT Connection Procedure to 
understand setting methods and key points to perform PDO Communications via EtherCAT.  
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5. Applicable Devices and Device Configuration 
 

5.1. Applicable Devices 
The applicable devices are as follows: 
 
Manufacturer Name Model 
OMRON NJ/NX-series CPU Unit NX701-17[][] 

NX701-16[][] 
NX1P2-11[][][][] 
NX1P2-10[][][][] 
NX1P2-90[][][][] 
NJ501-[]5[][] 
NJ501-[]4[][] 
NJ501-[]3[][] 
NJ301-12[][] 
NJ301-11[][] 
NJ101-10[][] 
NJ101-90[][] 

CKD ABSODEX Driver AX9000TS/TH-U5 
CKD Actuator AX-T Series  

 

 Precautions for Correct Use 

In this guide, the devices with models and versions listed in 5.2. Device Configuration are 
used as examples of applicable devices to describe the procedures for connecting the 
devices and checking their connections.  
You cannot use devices with versions lower than the versions listed in 5.2. 
To use the above devices with models not listed in 5.2. or versions higher than those listed in 
5.2., check the differences in the specifications by referring to the manuals before operating 
the devices. 

 

 
Additional Information 
This guide describes the procedures for establishing the network connections.  
It does not provide information on operation, installation, wiring method, device functionality, 
or device operation, which is not related to the connection procedures.  
Refer to the manuals or contact the device manufacturer.  

 

 
Additional Information 
Contact CKD Corporation for Actuators connectable to the ABSODEX Driver. 
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5.2. Device Configuration 
This guide describes the connection procedures using an NJ-series Controller.  
The hardware components to reproduce the connection procedures in this guide are as 
follows:  
 

  
 

 
 
 
 
 
 
 

Manufacturer Name Model Version 
OMRON NJ-series CPU Unit 

(Built-in EtherCAT port) 
NJ501-1500 Ver.1.13 

OMRON Power Supply Unit NJ-PA3001  
OMRON Sysmac Studio SYSMAC-SE2[][][] Ver.1.17 
- Personal computer  

(OS: Windows 7) 
-  

- USB cable  
(USB 2.0 type B connector) 

-  

OMRON Ethernet cable (with industrial 
Ethernet connector) 

XS5W-T421-[]M[]-K  

CKD RS-232C cable AX-RS232C-9P  
CKD ABSODEX Driver  AX9000TS-U5 Rev.0x0000

0001 
CKD Actuator AX4009T  
CKD AXTools - V2.13 
CKD ESI file CKD_ABSODEX_ECAT_161

206.xml 

 

- External power supply (24 VDC) -  

 

 Precautions for Correct Use 

Prepare the ESI file listed above beforehand.  
To obtain the ESI file, contact CKD Corporation. 

 

 Precautions for Correct Use 

The connection line of EtherCAT communications cannot be shared with other Ethernet 
networks.  
Do not use devices for Ethernet such as a switching hub.  
Use an Ethernet cable (double shielding with aluminum tape and braiding) of Category 5 or 
higher, and use a shielded connector of Category 5 or higher.  
Connect the cable shield to the connector hood at both ends of the cable.  

  

USB cable 

NJ501-1500 
(Built-in EtherCAT port) 

Ethernet cable 

AX9000TS-U5 
 

AX4009T 

Personal computer  
(Sysmac Studio and 
 AXTools installed,  
OS: Windows 7) 
 

AX-RS232C-9P 

External power supply 
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 Precautions for Correct Use 

Update Sysmac Studio to the version specified in this Clause 5.2. or to a higher version.  
If you use a version higher than the one specified, the procedures and related screenshots 
described in Section 7. and subsequent sections may not be applicable.  
In that case, use the equivalent procedures described in this guide by referring to the Sysmac 
Studio Version 1 Operation Manual (Cat. No. W504).  

 

 Additional Information 
For specifications of Ethernet cables and network wiring, refer to Section 4. EtherCAT 
Network Wiring of the NJ/NX-series CPU Unit Built-in EtherCAT® Port User's Manual (Cat. 
No. W505).  

 

 Additional Information 
For external power supply specifications, refer to the Instruction Manual ABSODEX AX 
Series TS type TH type EtherCAT specification (SMF-2012-A). 

 

 Additional Information 
The system configuration in this guide uses USB for the connection between the personal 
computer and the Controller. For information on how to install the USB driver, refer to A-1 
Driver Installation for Direct USB Cable Connection of the Sysmac Studio Version 1 
Operation Manual (Cat. No. W504).  
For NX1P2 Controllers, there is no need to install the USB driver because they do not have a 
USB port.  

 

 Additional Information 
The NX1P2 Controller, if used, should be connected to your personal computer with an 
Ethernet cable. For information on how to connect the cable, refer to 6-2 Going Online with a 
Controller of the Sysmac Studio Version 1 Operation Manual (Cat. No. W504).  
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6. EtherCAT Settings 
 
This section describes the parameters and device variables that are all defined in this guide.  
Hereinafter, the ABSODEX Driver is referred to as the "slave unit" in some descriptions.  
 
 

6.1. Parameters 
The parameters required for connecting the Controller and the ABSODEX Driver via EtherCAT 
are shown below.  
 

Name Item Set value 
ABSODEX 
Driver  

Node address (set in AXTools) 1 
Setting of Device ID to Station Alias register Set (Default) 

Controller Priority-4 Primary Periodic Task 1ms (Default) 
 

 Precautions for Correct Use 

Set Period/Execution Conditions to 1ms or more for the Controller's primary periodic task 
because the minimum task period of the ABSODEX Driver is 1ms.  
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6.2. Device Variables 
The PDO communications data with the ABSODEX Driver are assigned to the Controller's 
device variables.  
The device variable names and data types are shown below.  
 
■Output area (Controller to ABSODEX Driver) 

Device variable name Data type Bit Description 
E001_1st_Receive_PDO_Mapping
_Input_signal_1_2001_01 

UDINT 0 to 3 Program number selection input (bits 0 to 3) 

4 Program number setting input, second digit/:  
Program number selection input (bit 4) 

5 Program number setting input, first digit/ 
Program number selection input (bit 5) 

6 Reset input 
7 Origin return command input 
8 Start input 

9 Servo-on input/  
Program stop input 

10 Ready return input/  
Continuous rotation stop input 

11 Answer input/  
Position deviation counter reset 

12 Emergency stop input 
13 Brake off input 
14 Jog operation input (CW direction) 
15 Jog operation input (CCW direction) 

16, 17 Reserved/  
Travel unit selection input (bits 0 and 1) 

18 Reserved/  
Travel speed unit selection input 

19 Table operation, data input operation 
Switching input 

20 to 31 Reserved 
E001_1st_Receive_PDO_Mapping
_Input_signal_2_2001_02 

UDINT 0 Monitor output execution request 
1 Command code execution request 
2 to 31 Reserved 

E001_1st_Receive_PDO_Mapping
_Input_data_1_2003_01 

DINT - Monitor code 1 

E001_1st_Receive_PDO_Mapping
_Input_data_2_2003_02 

DINT - Monitor code 2 

E001_1st_Receive_PDO_Mapping
_Input_data_3_2003_03 

DINT - Monitor code 3 

E001_1st_Receive_PDO_Mapping
_Input_data_4_2003_04 

DINT - Monitor code 4 

E001_1st_Receive_PDO_Mapping
_Input_data_5_2003_05 

DINT - Monitor code 5 

E001_1st_Receive_PDO_Mapping
_Input_command_1_2003_06 

DINT - Command code 

E001_1st_Receive_PDO_Mapping
_Input_command_2_2003_07 

DINT - Written data  
/A code or P code 

E001_1st_Receive_PDO_Mapping
_Input_command_3_2003_08 

DINT - Data designation  
/F code   
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■Input area (ABSODEX Driver to Controller) 
Device variable name Data type Bit Description 

E001_1st_Transmit_PDO_Mapping
_Output_signal_1_2005_01 

UDINT 0 to 7 M code output (bits 0 to 7) 
8 In-position output 
9 Positioning completion output 
10 Start input wait output 
11, 12 Alarm outputs 1 and 2 

13 Indexing-in-progress output 1  
/Origin position output 

14 Indexing-in-progress output 2  
/Servo state output 

15 Ready state output 
16 Segment position strobe output 
17 M code strobe output 
18 to 31 Reserved 

E001_1st_Transmit_PDO_Mapping
_Output_signal_2_2005_02 

UDINT 0 Monitoring 
1 Command code execution complete 
2 to 31 Reserved 

E001_1st_Transmit_PDO_Mapping
_Output_data_1_2007_01 

DINT - Monitor data 1 

E001_1st_Transmit_PDO_Mapping
_Output_data_2_2007_02 

DINT - Monitor data 2 

E001_1st_Transmit_PDO_Mapping
_Output_data_3_2007_03 

DINT - Monitor data 3 

E001_1st_Transmit_PDO_Mapping
_Output_data_4_2007_04 

DINT - Monitor data 4 

E001_1st_Transmit_PDO_Mapping
_Output_data_5_2007_05 

DINT - Monitor code 5 

E001_1st_Transmit_PDO_Mapping
_Output_command_1_2007_06 

DINT - Response code 

E001_1st_Transmit_PDO_Mapping
_Output_command_2_2007_07 

DINT - Loaded data 

E001_1st_Transmit_PDO_Mapping
_Output_command_3_2007_08 

DINT - Reserved 

 

 Additional Information 
For details on the assignment of the input and output areas, refer to 3.2. Input/Output of the 
Instruction Manual ABSODEX AX Series TS type TH type EtherCAT specification 
(SMF-2012-A). 

 

 Additional Information 
The device variables are automatically named from a combination of the device names and 
the port names.  
The default device names are "E" followed by a serial number that starts from 001.  
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7. EtherCAT Connection Procedure 
 
This section describes the procedures for connecting the Controller and the ABSODEX Driver 
via EtherCAT. The explanations of the procedures for setting up the Controller and the 
ABSODEX Driver given in this guide are based on the factory default settings.  
For the initialization, refer to Section 8. Initialization Method.  
 

7.1. Work Flow 
Take the following steps to connect the Controller and the ABSODEX Driver via EtherCAT to 
perform PDO communications.  

 

7.2. CKD ABSODEX Driver Setup  Set up the CKD ABSODEX Driver. 

↓   

 7.2.1. Hardware Settings  Connect the cables to the ABSODEX Driver. 

↓   

 7.2.2. Parameter Settings   Set the parameters for the ABSODEX Driver. 

↓   

7.3. Controller Setup   Set up the Controller.  

↓   

 7.3.1. Starting Sysmac Studio and 
Installing the ESI File 

 Install the ESI file for the ABSODEX Driver in Sysmac 
Studio. 

↓   

 7.3.2. Setting up the EtherCAT 
Network Configuration  

 Set up the EtherCAT network configuration.  

↓   

 7.3.3. Setting the Device Variables  Set the device variables to use for the slave unit.  

↓   

 7.3.4. Transferring the Project Data  Transfer the project data created in Sysmac Studio to 
the Controller.  

↓   

7.4. EtherCAT Communication 
Status Check  

 Confirm that PDO communications performs normally 
via EtherCAT.  

↓   

 7.4.1. Checking the Connection 
Status 

 Check the connection status of the EtherCAT network.  

↓   

 7.4.2. Checking the Sent and 
Received Data 

 Check that the correct data are sent and received.  
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7.2. CKD ABSODEX Driver Setup 
Set up the CKD ABSODEX Driver. 
 

7.2.1. Hardware Settings 
Connect the cables to the ABSODEX Driver. 
 

 Precautions for Correct Use 

Make sure that the power supplies are OFF when you set up.  
If either of them is ON, the settings described in the following steps and subsequent 
procedures may not be applicable.  

 

1 Make sure that ABSODEX 
Driver and the external power 
supply are OFF. 

 

2 Check the position of the 
connectors on ABSODEX Driver 
by referring to the figure on the 
right.  

 

3 Connect Actuator to Resolver 
cable connector with a 
dedicated resolver cable. 
 
 
 
Connect Actuator to Actuator 
output terminal with a dedicated 
motor cable. 

 

Actuator 

Main power 

Control power 

Actuator output 
terminal 

RS-232C 
connector 

Resolver cable 
connector 

Safety function 
terminal 

EtherCAT 
connector 

Emergency stop 
terminal 

Brake terminal 

Resolver cable 

Motor cable 
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4 Connect an Ethernet cable to 
EtherCAT connector (IN). 

Ethernet cable 
 
 
 
 
 
 

5 Connect an RS-232C cable 
between RS-232C connector on 
ABSODEX Driver and the serial 
connector on Personal 
computer.  

6 Check that the safety function is 
invalidated.  
 
*Since the intention of this guide 
is to verify the network 
connection, the safety function 
is left invalid.  

 
*Refer to 3.2.6. Wiring for Safety 
Function of the INSTRUCTION 
MANUAL ABSODEX AX 
SERIES TS TYPE TH TYPE 
XS TYPE (SMF-2006-A) for 
wiring to Safety function 
terminal.  

 

*A jumper is connected to Safety function terminal to 
invalidate the safety function when ABSODEX Driver is 
shipped from the factory. 

7 Wire External power supply to 
Emergency stop terminal. 
 
*Refer to 2.3.1. Wiring of 
Emergency Stop Input (TB3) of 
the Instruction Manual 
ABSODEX AX Series TS type 
TH type EtherCAT specification 
(SMF-2012-A) for wiring to 
Emergency stop terminal. 

 
 
 

 

＋S1 

＋S2 

－S1 

－S2 

External  
power supply 

Personal 
computer 

RS-232C cable 
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8 Wire AC power supply for 
ABSODEX Driver to the 
connectors of Main power and 
Control power. 
 
*For capacities of Main power 
and Control power, refer to 
Table 3.3 Power Supply and 
Circuit Breaker Capacities in 
3.2.2. Connection to Power 
and Actuator (CN4, CN5) or 14. 
DRIVER SPECIFICATIONS of 
the INSTRUCTION MANUAL 
ABSODEX AX SERIES TS 
TYPE TH TYPE XS TYPE 
(SMF-2006-A). 

 
*For wiring to Main power and 
Control power, refer to 3.2.2. 
Connection to Power and 
Actuator (CN4, CN5) of the 
INSTRUCTION MANUAL 
ABSODEX AX SERIES TS 
TYPE TH TYPE XS TYPE 
(SMF-2006-A). 

 
 
 

 

  

AC power supply 

Main power 

Control power 
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7.2.2. Parameter Settings  
Set the parameters for the ABSODEX Driver. 
 

 Precautions for Correct Use 

Refer to 5.5.4. Main Power Supply Sequence of the INSTRUCTION MANUAL ABSODEX AX 
SERIES TS TYPE TH TYPE XS TYPE (SMF-2006-A) for information on the turn-on 
sequence of the main and control power supplies to the ABSODEX Driver. 

 

1 Turn ON ABSODEX Driver.  

2 Start AXTools. 

 

3 The New Dialog Box is 
displayed. Select online. 
Select the COM port number 
intended for use from the 
pull-down list of Communication 
port selection. Click OK. 
 
 
 
 
 
 
 
 
 
 
*If there is more than one serial 
port on Personal computer, 
display Windows Device 
Manager and select the same 
port as the communications 
port number under Ports (COM 
&LPT) where ABSODEX Driver 
is connected.  
(COM1 in this example) 
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4 A confirmation dialog box is 
displayed. Check the contents 
and click OK.  

  

5 AXTools starts.  
 

 

6 Select the Set Tab. 
The View of the Set Tab is 
displayed.  
Select Field Bus setting from 
the Ribbon Menu, then select 
EtherCAT setting.  

 

7 The EtherCAT register Dialog 
Box is displayed.  
Make the following settings.  

Device ID: 1 
Setting of Device ID to Station 
Alias register: Set 
 

Click Set (ABSODEX). 
  

Tab Ribbon Menu 

View 
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8 A confirmation dialog box is 
displayed. Check the contents 
and click OK.  

 

9 Click Close to close the 
EtherCAT register Dialog Box. 

 

10 Select the Home Tab. 
The View of the Home Tab is 
displayed.  
Select Exit from the Ribbon 
Menu to exit AxTools. 

 

11 Turn OFF ABSODEX Driver.  
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7.3. Controller Setup 
Set up the Controller.  
 

7.3.1. Starting Sysmac Studio and Installing the ESI File 
Install the ESI file for the ABSODEX Driver in Sysmac Studio.  
Install Sysmac Studio and the USB driver on your personal computer beforehand.  
 

1 Connect the Ethernet cable to 
the built-in EtherCAT port 
(PORT2) on Controller, and 
connect a USB cable to the 
peripheral (USB) port. As shown 
in 5.2. Device Configuration, 
connect Personal computer and 
ABSODEX Driver to Controller.   

 

2 Turn ON the external power 
supply, Controller and 
ABSODEX Driver. 

 

3 Start Sysmac Studio.  
 
*If the User Account Control 
Dialog Box is displayed at start, 
make a selection to start 
Sysmac Studio.  

 

4 Sysmac Studio starts.  
Click Connect to Device.  

 

5 The Connect to Device Dialog 
Box is displayed.  
Select Direct connection via 
USB in the Connection type 
Field. Uncheck both Transfer 
from Device and Display the 
Troubleshooting Dialog Box in 
the Operation after Connection 
Field.  
 
Click Connect.  

 

USB cable End Cover 

Power Supply Unit 
Ethernet cable 

CPU Unit 
Controller 

ABSODEX 
Driver 

Personal 
computer 
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6 The dialog box on the right is 
displayed. Check the contents 
and click OK.  
 
*The contents of the dialog box 
vary depending on the status of 
Controller. Check the contents 
and click on an appropriate 
button to proceed with the 
processing.  

 

7 The dialog box on the right is 
displayed. Check the contents 
and click OK.  

 

8 The Auto Connect Project 
Dialog Box is displayed online.  
When an online connection is 
established, a yellow bar is 
displayed under the toolbar.  
 
The following panes are 
displayed in this window.  
Left: Multiview Explorer 

Top right: Toolbox 

Bottom right: Controller Status Pane 

Top middle: Edit Pane 

The following tabs are displayed 
in the bottom middle of this 
window.  
Output Tab Page 

Build Tab Page 

 

 

 

 Additional Information 
For details on the online connections to the Controller, refer to Section 6. Online Connections 
to a Controller of the Sysmac Studio Version 1 Operation Manual (Cat. No. W504).  

 

9 Double-click EtherCAT under 
Configurations and Setup in 
the Multiview Explorer.  

 

Controller 
status 
Pane 

Build Tab 
Page 

Output Tab 
Page 

Multiview 
Explorer Edit Pane 

Toolbox 
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10 The EtherCAT Tab Page is 
displayed in the Edit Pane.  

 

11 Right-click Master and select 
Display ESI Library.  

 

12 The ESI Library Dialog Box is 
displayed. Click the this folder 
link.  
 
When the Explorer starts, click 
Close to close the dialog box.  

 

13 The Explorer starts, and a folder 
is opened, allowing you to install 
the ESI file. Copy the prepared 
CKD_ABSODEX_ECAT_16120
6.xml to this folder.   
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14 Select Exit from the File Menu 
to exit Sysmac Studio.  
 
*You need to restart Sysmac 
Studio after installing the ESI 
file.  

 
 
 
 
 
 
 
A dialog box is displayed 
confirming whether to save the 
project. If you do not need to 
save it, click No.  

 

 

15 In the same way as steps 3 to 
11, restart Sysmac Studio and 
display the ESI Library Dialog 
Box.  
Click the + Button of 
CKD_ABSODEX_ECAT_16120
6 to check that AX9000TS-U5 
Rev:0x00000001 
(AX9000TS-U5) is displayed. 
 
Check that an exclamation mark 
(warning) is not displayed.  
 
Click Close. 

 
 

 

 

 Precautions for Correct Use 

If an exclamation mark (warning) is displayed for the ESI file, check the name of the ESI file 
and obtain the ESI file with a correct name. If an exclamation mark (warning) is displayed 
even when the name of the ESI file is correct, the file may be corrupted.  
In that case, contact the device manufacturer.  
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7.3.2. Setting up the EtherCAT Network Configuration 
Set up the EtherCAT network configuration.  

 

1 Right-click Master on the 
EtherCAT Tab Page of the Edit 
Pane, and select Compare and 
Merge with Actual Network 
Configuration.  
 
*If the EtherCAT Tab Page is not 
displayed in the Edit Pane, take 
step 9 in 7.3.1. Starting 
Sysmac Studio and Installing 
the ESI File to display.  

 
 
 
 
 
A screen is displayed stating 
"Get information is being 
executed".  

 
 

 

2 The Compare and Merge with 
Actual Network Configuration 
Dialog Box is displayed.  
The node address 1 and 
AX9000TS-U5 Rev:0x00000001 
are added to the Actual network 
configuration after the 
comparison.  
 
Click Apply actual network 
configuration.  

 

3 The dialog box on the right is 
displayed. Check the contents 
and click Apply.  
 
The dialog box on the right is 
displayed. Check the contents 
and click Close.  
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4 As a node address 1 slave, 
E001 AX9000TS-U5 
Rev:0x00000001 is added to the 
Network configuration on 
Sysmac Studio. 
 
Check that the data above is 
added. Click Close.  

 
 

 

5 The node address 1 and E001 
AX9000TS-U5 Rev:0x00000001 
are added to the EtherCAT Tab 
Page of the Edit Pane.  
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7.3.3. Setting the Device Variables 
Set the device variables to use for the slave unit.  

 

1 Select Offline from the 
Controller Menu.   
 
 
 
 
 
The yellow bar under the toolbar 
disappears.  

 
 

 

2 Select the device with node 
address 1 added on the 
EtherCAT Tab Page in 
Sub-Clause 7.3.2.  
Check that the device name is 
E001.  
 
*The device name can be 
changed as desired.  

 

3 Double-click Task Settings 
under Configurations and 
Setup in the Multiview Explorer.  

 

4 The Task Settings Tab Page is 
displayed in the Edit Pane.  
Check that 1ms is set in the 
Period/Execution Conditions 
Column for Priority-4 Primary 
Periodic Task.   

5 Double-click I/O Map under 
Configurations and Setup in 
the Multiview Explorer.  
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6 The I/O Map Tab Page is 
displayed in the Edit Pane.  
Check that Node1 is displayed 
in the Position Column and that 
the added slave unit is displayed 
in the Port Column.  
 
*To manually set a variable 
name for the slave unit, click an 
entry cell in the Variable 
Column and enter a name.  

 

7 Right-click Node1 and select 
Create Device Variable.  

 

8 The variable names and types 
are set.  

 
 

 Additional Information 
The device variables are automatically named from a combination of the device names and 
the port names.  
The default device names are "E" followed by a serial number that starts from 001.  

 

 Additional Information 
In this guide, device variables are automatically named for each unit (each slave).  
They can also be manually named for each port.  
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7.3.4. Transferring the Project Data  
Transfer the project data created in Sysmac Studio to the Controller.  
 

 
Regardless of the operating mode of the CPU Unit, devices or machines may 
perform unexpected operation when you transfer any of the following data from 
Sysmac Studio: a user program, configuration data, setup data, device 
variables, or values in memory used for CJ-series Units.  
Always confirm safety at the destination node before you transfer the project 
data.  

 

 

 

If you use EtherCAT slaves, check the specifications of those slaves in manuals 
or other documentation and confirm that the system will not be adversely 
affected before you transfer parameters.  

 

 

 
After you transfer the project data, the CPU Unit restarts, and communications 
with the slave unit is cut off. During the period, the outputs of the slave unit 
behave according to the slave unit settings. The time that communications is cut 
off depends on the EtherCAT network configuration.  
Before you transfer the project data, confirm that the slave unit settings will not 
adversely affect the device.  

 

 
 

1 Select Check All Programs 
from the Project Menu.  

 

2 The Build Tab Page is displayed.  
Check that "0 Errors" and "0 
Warnings" are displayed.  

 

3 Select Rebuild Controller from 
the Project Menu.  
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4 The dialog box on the right is 
displayed. Confirm that there is 
no problem, and click Yes. 

 

5 Check that "0 Errors" and "0 
Warnings" are displayed on the 
Build Tab Page.  

 

6 Select Online from the 
Controller Menu.  
 
 
 
 
When an online connection is 
established, a yellow bar is 
displayed under the toolbar.  

 
 

 

7 Select Synchronization from 
the Controller Menu.  

 

8 The Synchronization Dialog Box 
is displayed.  
Check that the data to transfer 
(NJ501 shown on the right) is 
selected.  
Click Transfer To Controller.  
 
*After executing "Transfer To 
Controller", the Sysmac Studio 
data is transferred to 
Controller, and the data is 
synchronized.  
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9 The dialog box on the right is 
displayed. Confirm that there is 
no problem, and click Yes.  
 
 
A screen is displayed stating 
"Synchronizing". 
 
 
The dialog box on the right is 
displayed. Confirm that there is 
no problem, and click No. 
 
*Do not return to RUN mode.  

 
 

 
 

 

10 Check that the synchronized 
data is displayed with the color 
specified by "Synchronized" and 
that a message is displayed 
stating "The synchronization 
process successfully finished".  
Confirm that there is no 
problem, and click Close.  
 
*A message is displayed stating 
"The synchronization process 
successfully finished" if the 
Sysmac Studio project data 
coincides with the Controller 
data.  

 
*If the synchronization fails, 
check the wiring and repeat 
from step 1.  
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7.4. EtherCAT Communication Status Check 
Confirm that PDO communications performs normally via EtherCAT.  
 

7.4.1. Checking the Connection Status 
Check the connection status of the EtherCAT network.  
 

1 Check with LED indicators on 
Controller that PDO 
communications via EtherCAT 
performs normally.  
 
The LED indicators in normal status 
are as follows:  

NET RUN: Green lit 
NET ERR: Not lit 
LINK/ACT: Yellow flashing  

 
*The NX-series Controllers also 
have the same LED indicator 
status.  

 
 
 
 

 

2 Check the LED indicators on 
ABSODEX Driver. 
 
The LED indicators in normal status 
are as follows:  

RUN: Green lit 
ERR: Not lit 
L/A IN: Green blinking 

 
 

 
  

L/A IN 

ERR 

RUN 
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7.4.2. Checking the Sent and Received Data 
Check that the correct data are sent and received.  
In this procedure, the ABSODEX Driver receives a request from the Controller to output 
"Current position" (unit: pulse) (hereinafter referred to as "the Current position (pulse)"), and 
the value of the Current position (pulse) that is outputted by the ABSODEX Driver is confirmed 
by the Controller. 
 

 
If you change the variable values on a Watch Tab Page when Sysmac Studio is 
online with the CPU Unit, the devices connected to Output Units may operate 
regardless of the operating mode of the CPU Unit. 
Always ensure safety before you change the variable values on a Watch Tab 
Page when Sysmac Studio is online with the CPU Unit.  

 

 
 

1 Select Watch Tab Page from the 
View Menu.  

 

2 Select the Watch1 Tab.  

 

3 Click Input Name and enter the 
following variable names for 
monitoring.  

E001_1st_Receive_PDO_Mappin
g_Input_data_1_2003_01 
(Monitor code 1) 

E001_1st_Receive_PDO_Mappin
g_Input_signal_2_2001_02 
(Bit 0: Monitor output execution 
request) 

E001_1st_Transmit_PDO_Mappi
ng_Output_data_1_2007_01 
(Monitor data 1) 
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4 Select the display format for each 
variable as follows:   

E001_1st_Receive_PDO_Mappin
g_Input_data_1_2003_01: 

Decimal 
E001_1st_Receive_PDO_Mappin

g_Input_signal_2_2001_02: 
Binary 

E001_1st_Transmit_PDO_Mappi
ng_Output_data_1_2007_01: 

Decimal 

 
 

 

5 Check that the following online 
values of the variables are 
displayed. 

E001_1st_Receive_PDO_Mappin
g_Input_data_1_2003_01: 0 

E001_1st_Receive_PDO_Mappin
g_Input_signal_2_2001_02: 

0000 0000 0000 0000 
0000 0000 0000 0000 

E001_1st_Transmit_PDO_Mappi
ng_Output_data_1_2007_01: 0 

 
 

 

 

6 In AXTools, select Motion from the 
Ribbon Menu in the View of the 
Monitor Tab.  
 
*If AXTools is not started, refer to 
7.2.2. Parameter Settings to start 
AXTools, then connect to 
ABSODEX Driver again.  

7 The Operation order menu Window 
is displayed. 
Check the value of Current position 
(Actuator) in the Present operation 
situation.  
(540671 pulses in this example) 

 

… 
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8 On the Watch Tab Page of Sysmac 
Studio, enter 3 in the Modify Column 
for E001_1st_Receive_PDO_ 
Mapping_Input_data_1_2003_01.  
 
The online value of E001_1st_ 
Receive_PDO_Mapping_Input_data
_1_2003_01 changes to 3. 
 
*For the above mentioned variable 
(Monitor code 1), set the code No. 
of the monitored item that you want 
to fetch into Monitor data 1. 
The code No. 3 is set in this guide, 
which indicates the Current 
position (pulse) as the monitored 
item. 

 
 
 
 

 

9 Enter 0000 0000 0000 0000 0000 
0000 0000 0001 in the Modify 
Column for E001_1st_Receive 
_PDO_Mapping_Input_signal_2_20
01_02. 
 
*The value of the code No. 3 (Current 
position (pulse)) that is set in step 8 
is stored by changing the bit 0 value 
(Monitor output execution request) of 
the above mentioned variable to 1 
(ON).  

 

 
 
 

 

10 Check that the following online 
value is displayed.  

E001_1st_Transmit_PDO_Mappi
ng_Output_data_1_2007_01 
(Monitor data 1): 540671 

 
This indicates that Controller has 
received 540671 as the Current 
position (pulse) of ABSODEX Driver 
and that the value is same as in step 
7. 
 
*The value of the Current position 
(Pulse) varies depending on the 
ABSODEX Driver used. 

 

 
 

 

 

 Additional Information 
For information on the monitor data output by setting the monitor codes, refer to 3.3.1. 
Monitor Code of the Instruction Manual ABSODEX AX Series TS type TH type EtherCAT 
specification (SMF-2012-A). 
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8. Initialization Method 
 
The setting procedures in this guide are based on the factory default settings.  
Some settings may not be applicable unless you use the devices with the factory default 
settings.  
 

8.1. Initializing a Controller 
To initialize a Controller, it is necessary to initialize a CPU Unit.  
Change the operating mode of Controller to PROGRAM mode and select Clear All Memory 
from the Controller Menu in Sysmac Studio. The Clear All Memory Dialog Box is displayed. 
Check the contents and click OK.  

 

 
 

8.2. Initializing a CKD ABSODEX Driver 
For information on how to initialize a CKD ABSODEX Driver, refer to 3-2-1-4 ABSDEX 
initialization of the INSTRUCTION MANUAL ABSODEX AX Tools for Windows® Common for 
TS-Type, TH-Type, MU-Type and XS-Type Drivers (SMF-2005-A).  
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9. Revision History 
 

Revision 
code 

Date of revision Description of revision 

01 September 5, 2017 First edition 
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